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iSeries Access for Windows — Sessions in Chicago

1. 26GH - MS Office with Client Access

2. 31GJ - Administration of iSeries Access for Windows: Advanced Tips

3. 31GH - MS Office and Client Access Integration Session 1: Setup and Overview

4. 32GH - MS Office and Client Access Integration Session 2: Word and Excel

5. 33GH - MS Office and Client Access Integration Session 3: Access-Web-Sending
Data

6. 36CA - iSeries Access for Windows: What’s New in V5R3

7. 41CB - iSeries Access Data Transfer: Tips and Techniques

8. 41LC - LAB: MS Office with CA/400

9. 42CB - iSeries Access for Windows: Security and Communications Tips
10. 44CA - iSeries Access for Windows in a .NET World

11. 45LA - OPEN LAB: iSeries Access for Windows with the Experts

12. 52CB - Everything you wanted to know about PC5250 emulation

13. 56CB - Performance Tune iSeries Access ODBC Driver
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===7z. Topics to be covered
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° PaCKaglng .St;'\el' iSeries Access for Windows

* Middleware

for Windows

* Data Transfer

innovative...

integrated...

\
« PC5250 """—-u,\l,. ’x\" impressive...
| | ."R ...iSeries

= - iSeries Access for Windows... the strategic
° Secu rlty il choice for interacting with and managing
your iSeries servers.

www.ibm.com/eserverl/iseries/access
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Integrating native Windows with iSeries
@server’

Want a single solution for working with all iSeries resources...

» A single offering designed for Windows users that provides:
— High-function, easy-to-use 5250 emulator to work with iSeries applications
— A PC print server that 0S/400 output can be sent to and run unattended
— Access to iSeries database and other resources from Windows application
— Ability to use iSeries as file and print server
— Administer users and monitor/manage iSeries servers in the network

» No special web application server code required

— All code runs natively on the Windows You have the
most
- It's all in iSeries Access for Windows c'omp_rehens.ive
— PC5250 emulation, Data Transfer, ODBC, etc for end users and ~ /Series native
Windows programmers WIndOW§
— iSeries Navigator to operate and administer iSeries systems and conrject'lwty
database solution in the
market

Operations Console to work with OS/400 system console
EZ-Setup to quickly and easily set up new iSeries servers

80+% of iSeries customers already using iSeries Access for Windows

©2004 1BM Corporation
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Packaging & Ordering
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iSeries Access for Windows

iSeries Access for Windows - Product Information
* 1st Release

— May 1999, VRM = V4R4MO
— End of Support 5/31/2001

» 2nd Release

— August 2000, VRM = V4R5M0

— End of Support 12/31/2002
* 3rd Release

What is iSeries Access for Windows?

Using iSeries Access for Windows

What's New in Y6R37

— May 2001, VRM = V5R1M0

— End of Support 5/312603 9/30/2005*
» 4th Release

Sources of Information

— August 2002, VRM = V5R2M0

— End of Support 9/36/2064 9/30/2005*
» 5th Release

¥ Show this Welcome when | restart my computer

— June 2004, VRM = V5R3M0 g
©2004 1BM Corporation
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Welcome to iSeries Access for




iSeries Access Family - Packaging
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V5R3
5722-XW1
iSeries Access Family

V5R2

g@\\ 5722-XW1
WP iSeries Access Family

iSeries Access for Windows
5722-XE1, V5R3

iSeries Access for Windows
5722-XE1, V5R2

iSeries Access for Web
5722-XH2, V5R3

iSeries Access for Web
5722-XH2, V5R2

WebSphere Host Publisher
5724-B81, V4.0

5724-B81, V4.01

HATS Limited Edition
5724-D34-01, V4.0

HATS Limited Edition
5724-F97-01, V5.0
iSeries Access for Linux,
5722-XL1, V5R3

You can get the V5R3 versions of iSeries
Access Family by ordering no-charge
Feature No. 2647 of Product No. 5722-
XW1

©2004 1BM Corporation
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Set up the License Key Information

iSeries Access Family (5722-XW1) is included on the Keyed
Stamped media.

» Can use all functions of iSeries Access Family for 70 days without
purchasing 5722-XW1.

To set up License key information for 5722-XW1

* Run WRKLICINF command.

— Type "1"in the entry field next to the product 5722XW1 Option 1,
Feature 5101.

— This is where you enter your software license key.
+ On the Add License Key Information (ADDLICKEY) display
— Type the required information and add the license key information

— Always enter the value *"NOMAX regardless of what was entered for
usage limit.

©2004 1BM Corporation
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Notes: Software License Keys .
@server

With V5R1, iSeries Client Access Family (Licensed Program number 5722-XW1) is added to the
Keyed Stamped Media to enable you to evaluate the function. This feature is for evaluation use
only and keys are not supplied. The Client Access functions that require the Client Access
Family license can be evaluated for 70 days. After 70 days, you need to order (or have
upgraded to) the V5R1 5722-XW1 product to receive the software license key. As in prior
releases, all components of Client Access Express can be installed on the PC, whether the
components require a license or not. Also as in prior releases, the 5722-XW1 license will be
checked at the point when a user tries to use a licensed function. The difference for V5R1 is
that now users will be allowed 70 days to evaluate the licensed functions without having the
license key.

The 5722-XW1 licensed program now has both a base and option 1.
Both need to be installed when XW1 is installed on the iSeries or iSeriese server.
5722-XW1 feature 5050, which is the base. This is where you need to enter your usage limit.

If you ordered a user-based option you would need to enter a use quantity equal to the number
of users you are entitled to use.
If you ordered the PBOTC option, you would enter a use quantity of “NOMAX."

5722-XW1 feature 5101, which is option 1. This is where you enter your software license key.

The screens for ADDLICKEY have a 'usage limit' value (for release-to-release compatibility) and
they cannot be left with the default of '0". Thus our instructions recommend that you enter a
value of *NOMAX. This field is ignored by Client Access license management as it checks the
usage limit value entered on the base.

©2004 IBM Corporation iseries mvseries
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PC Hardware Requirements

Connection Options

©2004 1BM Corporation
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Windows Operating Systems
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The V5R3 version of iSeries
Access for Windows will not

install on:

— Windows 95 i
— Windows 98

— Windows ME » The V5R2 version of

iSeries Access for
Windows can be used
on Windows 98, ME, NT
4.0, 2000, XP, 2003

The V5R3 version of iSeries
Access for Windows can be

installed on:
— Windows NT 4.0 * The V5R1 version of
— Windows 2000 iSeries Access for
— Windows XP Professional Windows can be used
— Windows 2003 Server el AITOe ), 28}

ME, NT 4.0, 2000, XP

©2004 1BM Corporation
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Firewalls and Windows XP Service Pack %@ —

* By default, once Windows XP SP2 is installed, the Windows
Firewall is automatically configured to prevent some incoming
connections into the PC. This can affect the following iSeries
Access for Windows functions:

— Incoming Remote Commands
— Operations Console
— Management Central

« If you are using these functions, and they stop working once
Windows XP SP2 is installed, here are steps you can take ...

©2004 1BM Corporation
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Incoming Remote Command

@server’
Incoming Remote Command uses port 512 by default
» Typical error messages would be:
— CPE3447 "A remote host did not respond within the timeout period"
— rexec:connect:Connection timed out
— rexec: can't establish connection
» Solution:

— Configure a port exception to allow incoming TCP connections on port
512:

C:\> netsh firewall add portopening TCP 512 "rexecd server (exec service,
port 512)"
-OR -
— Configure an application exception to allow the iSeries Access for
Windows Remote Command service (cwbrxd.exe) to accept any incoming
connection, regardless of port number or protocol:

C:\> netsh firewall add allowedprogram %windir%\cwbrxd.exe "iSeries
Access Incoming Remote Command server"

©2004 1BM Corporation
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Operations Console
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Operations Console uses ports 67 and 2112 for local (async
and LAN) connections

« Can use any one of a number of different ports for RCS ->
LCS connections

* Typical failures are:

— When connecting an LCS (local connection), the status may not
progress beyond "connecting console".

— When connecting an RCS (remote connection) to an LCS that

— has not had all needed firewall exceptions configured, it may
fail to connect; or it may connect but fail to authenticate.

» The failure reason noted at the RCS may be that the local
system is not configured to receive calls.

©2004 1BM Corporation
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= =.  Operations Console (continued...) .
@server

Steps to correct:
+ Configure a port exception to allow incoming UDP connections on port 67:

— C:\> netsh firewall add portopening UDP 67 "bootp server (bootps service, port 67)*

» Configure a port exception to allow incoming TCP connections on port 2112
from the local PC (127.0.0.1) only:

— C:\> netsh firewall add portopening TCP 2112 "Internal Op Console worker server (port
2112)" ENABLE CUSTOM 127.0.0.1

» Configure an application exception to allow the Operations Console program to
accept any incoming connection, regardless of port number or protocol:

— C:\> netsh firewall add allowedprogram <INSTALL>\cwbopcon.exe "iSeries Access
Operations Console (cwbopcon)"

©2004 IBM Corporation iseries mvseries
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Management Central

@ server’
Refer to:
* For V5R3:

http://publib.boulder.ibm.com/infocenter/iseries/v5r3/ic2924/info/experience/mcfir
ewall.pdf

* For V5R2:
http://publib.boulder.ibm.com/iseries/v5r2/ic2924/info/experience/mcfirewall.pdf

These reports detail Management Central connections and the configurations required to enable
Management Central to operate within a variety of firewall environments. As a distributed management
application, Management Central requires numerous incoming and outgoing TCP/IP socket
connections.

In contrast, the basic premise of a firewall is to restrict/modify incoming and outgoing connections.

To assist in configuring Management Central within a firewall environment, these reports discuss the
nature and orientation of Management Central connections and the restrictions of specific types of
firewalls that limit or disable some Management Central connections.

©2004 1BM Corporation iseries mvseries
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Info on Web

@server’
The preceding information on Windows XP SP2 is also
available on the web at:
— http://www-
1.ibm.com/servers/eserverliseries/access/supportedos.htm
— Then click on the appropriate link in the Windows XP
Professional section
©2004 IBM Corporation iseries. mvseries.
=. Hardware/Software requirements...
@server
Operating iSeries Access for Windows iSeries Navigator
system
Windows NT |+ Pentium 100 MHz and at least » Pentium 850 MHz minimum and at least
4.0 32 MB 256 MB, 512 MB recommended
» Microsoft Windows NT Service |« Microsoft Windows NT Service Pack 6a
Pack 6a » Microsoft Internet Explorer 5.01 or later
» Microsoft Internet Explorer 5.01
or later
Windows » Pentium 133 MHz and at least « Pentium 850 MHz minimum and at least
2000 64 MB 256 MB, 512 MB recommended
» Pentium 850 MHz minimum and
at least

256 MB, 512 MB recommended
Windows XP | « Pentium 233 MHz and at least Pentium 850 MHz and at least 256 MB,
128 MB 512 MB recommended

Windows « 32-bit PC Pentium 133 MHz Pentium 850 MHz and at least 256 MB,
Server 2003 and at least 128 MB Pentium 512 MB recommended

64-bit PC Pentium 733 MHz
and at least 192 MB

Note: If you do not plan to use iSeries Navigator for anything other than managing your iSeries connections (adding,

removing, and changing connection properties), it is recommended that you do not install the iSeries Navigator base
component. Installing that component will result in higher memory usage when managing your iSeries connections.

.

©2004 1BM Corporation iseries mvseries
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Hardware/Software requirements...

@server’

Other PC requirements Value

Disk Space - Install + Typical - 148 MB (approximately)

+ PC5250 User - 39 MB (approximately)

* Full - 221 MB (approximately)

+ Custom - varies, depending on
components installed

Adapter Card A communications adapter card that supports

TCP/IP.

Notes

1.

The Disk Space - Install values are approximate. For the exact values, see PC requirements
(www.ibm.com/eservers/iseries/access/pcreq.htmi)

2. You need 5 MB available on the drive where the Windows operating system is installed to
accommodate temporary files that the iSeries Access for Windows setup program creates.

3. Additional files are downloaded from the iSeries server when you use the File Systems function of
iSeries Navigator.

4. Service packs require additional space.

5. The size for a Full installation could be different depending on whether SSL and plug-ins are in the
installation search path.

©2004 1BM Corporation .ser Ies. mv ser.es.

Supports Microsoft operating environments...

@ server’
Microsoft Transaction Services
(MTS)
— example, an Auction House application Windows
where may need to back out
transactions (ie, 2-phase commit) Network
Stations _?—
. " -I
Terminal Server Edition (TSE) =

Internet Information Services (lIS)

— iSeries Access runs on a Windows

server, and enables multiple IFS Windows
simultaneous users (such as Network Under
Stations, DOS, Unix, or Macintosh) iSeries
work with iSeries resources (iXS,
iXA)
web server

— Provides a Web application
infrastructure for Windows Servers.
iSeries Access runs on server, and
fulfills requests for iSeries data (ie,
ODBC, OLE DB, etc)

©2004 1BM Corporation iseries mvseries
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Installing

iSeries
NetServer
\QIBM -->
\ProdData -->
\CA400 -->

\Express -->

L

\Install -->

\Image

©2004 IBM Corporation iseries myseries
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iSeries Access for Windows installs @server'

code in iSeries IFS (NetServer)

iSeries Access client Install Image placed in IFS in:
— \QIBM\ProdData\CA400\Express\Install\lmage
— Already set up as 'shared’

Service Pack placed in IFS in:

— V5R1 - Service Pack PTFs saved in the main install image--no @]
extra reboot!

Express installs and services other code placed in IFS:
— Secure Sockets Layer (SSL) Encryption programs, iSeries
Navigator Plug-ins, Add-ins
— V5R1 - EZ Setup
Creating Customized Install CD images

— SSL component can now be included in your customized install
CD image (V5R2)

©2004 1BM Corporation iseries myseries
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Getting Started...

Many new Emulator  Program...  Service AFP Data Data
functions Toolkit Workben...  Trangf... Trancfer.. Update
available M = s : [y
from iSeries @ @ @ b EF—J
Access for EZ-Setup  Internet  iSeries  iSerles 0DBC  Operations  Read Me

Windows Information  Accessf... Navigator Administr.. Console

icon group... @ EF_J ﬁ’) g

Selective  Service Sta User's Guide  Welcome
Setup  PackRe..  Direct... Wizard

©2004 1BM Corporation
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iSeries Access for Programmers
Application Enablement

©2004 1BM Corporation
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iSeries Access Middleware

@server’

Middleware

Where it fits

Value to iSeries

iSeries ODBC driver

.

Industry-standard Windows database
access method.
Supports Microsoft V3.0 specification.

Access to DB2 UDB for iSeries

iSeries OLE DB provider
(driver)

Visual Basic Wizards

Microsoft's universal data access
standard interface for Windows
applications working with relational and
non-relational data.

Supports OLE DB 2.5

Can use ADO 2.2 and 2.5

Can use VB 6.0

Access to DB2 UDB for iSeries

Can use 0S/400 Data queues, Remote
Commands, Stored Procedures,
Distributed Program Calls...

VB Wizards can be used with iSeries
OLE DB provider

.NET Data provider called
IBM.Data.DB2.iSeries

Microsoft .NET Framework is a platform
for building, deploying, and running Web
Services and applications

Enables applications using Microsoft's
.NET framework to access DB2 UDB
for iSeries databases

Data Queues

Remote Commands
Stored Procedures
Distributed Program Calls
SQL APIs

Data Transfer APIs

.

Active X Automation Controls & Objects
Industry-standard Windows
programming interface

Works with OS/400 Data queues,
Remote Commands, Stored
Procedures, Distributed Program
Calls...

Access to DB2 UDB for iSeries

PC5250 enablers

.

Includes ActiveX controls
Industry-standard EHLLAPI, WinHLLAPI,
DDE for code conversion.

For 5250 applications
ENPTUI for enhanced 5250
datastream functions

©2004 1BM Corporation
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Notes: Middleware

iSeries ODBC Driver

ODBC is a Microsoft-defined standard database access
interface for Windows users. Client Access provides an iSeries
ODBC driver to enable any ODBC 32-bit Windows application
(written to MS V3.0 specification) to transparently access
DB2/400 information. iSeries ODBC driver supports Dynamic
SQL access at static SQL speed (4x improvement), Block
Fetch, Insert, Update, & Delete functions, takes advantage of
DB2/400 Optimizer, supports Stored Procedures (result sets
from stored procedures), SQL Collections do not need to be
defined

iSeries OLE DB Provider (driver)

OLE DB is a Microsoft 32-bit Windows architecture for
universal data access. OLE DB is defined as a multi-platform
access method for relational and non-relational data, and is a
superset of ODBC. Client Access includes an iSeries OLE
DB Provider so that any PC application written to this interface
can be used to access iSeries resources. The iSeries OLE DB
Provider can be used for record level access, SQL calls,
stored procedures, data queues, programs, and CL
commands. The OLE DB and ActiveX toolkit which provides
Visual Basic wizards and other sample programs is provided
as part of the Client Access Toolkit.

ActiveX Automation Objects

ActiveX automation objects are provided for Client Access data
queues, remote commands, and distributed program calls.
Many popular client languages, such as Visual Basic, Delphi,
PowerBuilder, and Visual C++, support ActiveX automation
objects, and now these programs can use the Express client
key components to develop client/server applications between
the PC and the iSeries. Online help (including example code)
is provided and can be accessed from object browsers.

@ server’

iSeries Toolbox for Java

The iSeries Toolbox for Java includes a series of low-level APIs for
accessing iSeries data and resources from a Java program. It also
includes a set of GUI classes to present iSeries data to the user
from a Java program. The GUI classes use the Java Swing 1.0
(JFC 1.1) framework. This is a separately installable option of
Client Access install. Once installed through Client Access, future
updates to the Java Toolbox will be delivered to PC users through
the Client Access 'service' function (ie, whenever a PTF for the
Java Toolbox is applied to the iSeries Check Service Level
recognizes the new level and downloads the fix to the client).

PC5250 Enablers
« EHLLAPI support is provided so programmers can add a

graphical interface to applications written to a 5250 interface to

perform functions such as host data access, screen scraping
and host automation. This industry-standard 32-bit support also
enables applications currently written to another emulation
products' EHLLAPI to migrate and run unchanged using

PC5250.

WinHLLAPI support is implemented so customers who have

WOSA-compliant applications can migrate to PC5250.

PC5250 DDE now includes code conversion support. This

provides a more consistent set of DDE APIs thus making it

easier to migrate applications across different platforms.

Enhanced Non-Programmable Terminal User Interface

(ENPTUI) provides 5250 datastream functions such as ability to

show radio buttons and check boxes on end-user desktops that

can support these functions (such as a PC versus a 5250

terminal).

« PC5250 ActiveX Controls have been added and can be used in
any application that supports ActiveX controls (such as Visual
Basic, C++, etc). These controls enable host applications to
use a list box or button.

©2004 1BM Corporation
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.NET is the next big wave in Microsoft technology...

Microsoft Technology Roadmap

Today

DB-Library €——————m— = = = = = —=| —

ESQL

DAO -

— e = -

OoDBC -

Y

ADO/OLEDB -
ADO.NET

Y

©2004 1BM Corporation
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Notes: What is Microsoft .NET

Microsoft .NET is software that connects information,
people, systems, and devices. It spans clients, servers,
and developer tools, and consists of:

+  The .NET Framework 1.1, used for building and running all
kinds of software, including Web-based applications, smart
client applications, and XML Web services—components
that facilitate integration by sharing data and functionality
over a network through standard, platform-independent
protocols such as XML (Extensible Markup Language),
SOAP, and HTTP.

«  Developer tools, such as Microsoft Visual Studio® .NET
2003 which provides an integrated development
environment (IDE) for maximizing developer productivity
with the .NET Framework.

«  Aset of servers, including Microsoft Windows® Server
2003, Microsoft SQL Server™, and Microsoft BizTalk®
Server, that integrates, runs, operates, and manages Web
services and Web-based applications.

Client software, such as Windows XP, Windows CE, and
Microsoft Office XP, that helps developers deliver a deep
and compelling user experience across a family of devices
and existing products.

The .NET Framework is an integral Windows .
component for building and running the next generation
of software applications and Web services. The .NET
Framework:

«  Supports over 20 different programming languages.

+  Manages much of the plumbing involved in developing
software, enabling developers to focus on the core business
logic code.

Makes it easier than ever before to build, deploy, and
administer secure, robust, and high-performing applications.
The .NET Framework is composed of the common language
runtime and a unified set of class libraries.

@ server’

Common Language Runtime

+  The common language runtime (CLR) is responsible for run-
time services such as language integration, security
enforcement, and memory, process, and thread management.
In addition, the CLR has a role at development time when
features such as life-cycle management, strong type naming,
cross-language exception handling, and dynamic binding reduce
the amount of code that a developer must write to turn business
logic into a reusable component.

Class Libraries
« Base classes provide standard functionality such as
input/output, string manipulation, security management, network
communications, thread management, text management, and
user interface design features.

The ADO.NET classes enable developers to interact with
data accessed in the form of XML through the OLE DB,
ODBC, Oracle, and SQL Server interfaces. XML classes
enable XML manipulation, searching, and translations.
The ASP.NET classes support the development of Web-
based applications and Web services. The Windows
Forms classes support the development of desktop-based
smart client applications.

Together, the class libraries provide a common, consistent
development interface across all languages supported by
the .NET Framework.

Note: The .NET Compact Framework does not ship
natively with the .NET Framework. Developers may
access the .NET Compact Framework using Visual Studio
.NET 2003.

©2004 1BM Corporation
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.NET Data Provider new in V5R3...

ADO.NET Managed Provider

UDB for iSeries databases

@server’

— The new .NET provider is named IBM.Data.DB2.iSeries

— It allows applications using Microsoft's .NET framework to access DB2

— For complete documentation of the .NET Data Provider, see IBM DB2
UDB for iSeries .NET Provider Technical Reference.

©2004 1BM Corporation
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.NET Provider

Supported

« SQL (INSERT,UPDATE, DELETE)
» Commitment Control

» Connection Pooling

» SQL naming

* Unicode

* Tracing

» Threads

* |ASPs (multiple databases)

» Compression

* Limited stored procedure support

@ server’
Not supported

 Large Objects (LOBs)
» System naming (/)

» Package support
 Data links

 User Defined Types

* Record Level Access
* CMD/PGM call

» Data Queues

©2004 1BM Corporation
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Notes: Using ADO.NET

@server’

The IBM DB2 UDB for iSeries .NET Provider (which is also called the Managed Provider or the
IBM.Data.DB2.iSeries data provider) is based on the ADO.NET architecture. ADO.NET is a set of classes
that uses .NET technologies to allow access to database servers. The IBM.Data.DB2.iSeries data provider
supports the full set of ADO.NET classes to allow your application to access and use data that is stored in
your iSeries DB2 database.

The IBM.Data.DB2.iSeries data provider is compiled for .NET and runs under the .NET Common Language
Runtime (CLR) function and, therefore, follows established .NET provider and class definitions.

According to ADO.NET rules, managed providers do not define traditional external data structures or
header files so your iSeries Access for Windows Managed Provider does not have a header file or unique
data structures.

ADO.NET data providers do not offer as many classes or interfaces as traditional data providers and the
properties for these classes are always a single word with no intervening spaces. This means that you can

get and set IBM.Data.DB2.iSeries data provider properties by simply calling to methods supported by the
various classes.

©2004 1BM Corporation
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iSeries ODBC Driver

@ server’

ODB¢

Most popular database
access method from a
Windows application

Compliant with Microsoft ODBC Version 3 specification

» PC applications can now take advantage of new functions
included in the 3.5 Specification.

©2004 1BM Corporation

iSeries. mySeries.




©2004 1BM Corporation

=. ODBC (Open Database Connectivity)...

@server’
V5R3 enhancements

» Support for BINARY/VARBINARY data types

» Support for UTF-8 / UTF-16 data

» Support for increased precision of decimal numbers

* Enhanced MTS support

+ ANSI/ISO (American National Standards

Institute/International Standards Organization) Core
Level SQL standard of 1999

iSeries. mySeries.

Microsoft Transaction Services (MTS)...V5R2

Bidder

©2004 1BM Corporation
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Using Electronic Data Interchange iSeries "bBank"
g 4 (EDI)
%%,
{)
% .
Y S«
Ss k.ﬁe’?o 4 o
! * 2 phase commit
$
s, O,
%q. g
Auction House Sqp R
& MTS and
N CA Express V5R1
ODBC Driver

This scenario assumes that the Auction
House would handle the transaction

iSeries. mySeries.




Notes: What is ODBC MTS Support?

@server’

What is MTS?

Microsoft Transaction Server (MTS) is a feature of the
Microsoft Windows NT and 2000 Server O/S for
development and deployment of three-tiered, server-
centric applications built using COM technologies. MTS
offers automatic transaction support, role-based security,
access to other databases (including connection pooling),
message queuing products and mainframe-based
applications.

What is in Express V4R4/5 ODBC for MTS?

Connection Pooling, which provides improved
performance, is already available as the Microsoft ODBC
driver manager handles it (ie, the Express ODBC driver
doesn't do anything different or special). The user can
turn connection pooling on and off via the ODBC
Administrator's 'Connection Pooling' tab. This displays a
list of the installed drivers, click on one to set whether
connection pooling will be enabled or not and set the
time-out value for unused connections.

The Express ODBC driver was made 'Thread Safe' via
V4R4 Service Pack SF59557. See Information APAR
1111851 for information on thread safety.

wi

hat is in Express V5R1 ODBC for MTS?

0S/400 V5R1 UDB/400 supports the X/Open XA
standard for transaction coordination that the ODBC
driver uses to provide two phase commit. ODBC driver
will accept the commands and send them to the iSeries
via a new set of database host server functions.

ODBC driver support the
SQLSetConnectAttr(SQL_ATTR_ENLIST_IN_DTC)
statement

The user can turn connection pooling on and off via the
ODBC Administrator's 'Connection Pooling' tab. This
displays a list of the installed drivers, click on one to set
whether connection pooling will be enabled or not and set
the time-out value for unused connections.

ODBC driver is thread safe (see Information APAR
1111851 which describes thread safety and documents
that since V4R4 Service Pack SF59557, our driver is
thread safe).

MTS Requirements and Restrictions

MTS 2.0 (Windows NT with Option Pack 4.0 or Windows
2000) installed in the second tier machine. Distributed
Transaction Coordinator (DTC) is included.

Client Access Express V5R1 with ODBC installed in the
same machine.

0S/400 V5R1 for two phase commit.

V5R1 MTS support is restricted to one transaction per
connection at a time.

©2004 1BM Corporation
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ODBC (Open Database Connectivity)...

V5R2 enhancements

* MTS support

* Working with iSeries Database

— Supports ROW-ID

— 64K SQL Statements

@ server’

— additional descriptor information

©2004 1BM Corporation
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iSeries OLE DB Provider

@server’

OVE Dg

Microsoft-recommended
Access for 32-bit Windows
applications

» Record level access
» Data Queues
 Stored Procedures
- SQL

» Remote Commands
- ODBC.

=" plus add-ins for Visual Basic

OLE DB Provider supports OLE DB 2.5
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Visual Basic Programming Aides

Link Data Queues. ..

@ server
ﬁPmiecH - Microsoft Yisual Basic [design] - [Form1 [Form]] =] |
I3 Ele Edit View Project Format Debug Run Guery Diagram Tools Add-Ins Window Help | Express Tookic ;Iilé"
B-ra-BEEH RN 0 =2 ) ) b MEEE kb
_ Link Stored Procedures. ..
LnE-E-5-e]
X

IsMl Project - Project

Link Commands. . .

HE Link Programs. ..
A Ia_b| R : E?%D::nls ¢ Create Form from Links, .,
" * Wizards to aid in : Froperties - Farm1 ‘Work with Stored Procedures, ..
] 1| . developing Visual 0| [Formirom Morkuth Oata Queues..

o H H H P ]

¥ & : Basic applications ; : phabetic | Cateac  cption...
e | Sample prog_rams for SEEEY ama) =T
y 2 - |E, PowerBuilder, sooaos ADDearznce 1-|3D p=
485 . H H pacaas AutoRedraw False
e g Delphl’ Vlsual C++’ B EackColor [ &H=000000F::
3 = : Lotus 1-2-3 coe Eorderstyle 2 - Sizable j
D o " "  |caption

Returnsfsets the kext displayed in an object's Litle
< _:: | | _>| bar or below an object's icon.
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OLE DB (Object Linking and Embedding)...

@server’
V5R3 Enhancements:

* New SQL-only provider (IBMDASQL)
— SQL commitment control using IBMDASQL
— MTS support using IBMDASQL
- SQL
— Custom blocking in SQL
— SQL data compression
— SQL package support
* New Record-Level Access-only provider (IBMDARLA)

— Record-level access support for forward-only cursors and blocked reads using
IBMDARLA

- DB2 UDB for iSeries support:
— Database BINARY and VARBINARY data types
— Database larger decimal precision support

* Unicode support
— UTF-8 and UTF-16 support

©2004 IBM Corporation iseries myseries
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OLE DB (Object Linking and Embedding)... @server'

OLE DB provider work with
Windows products, such as:
— ADO 2.1 - this ships with Microsoft IE 5.0

V5R2 enhancements...

and Office/2000 products » Working with iSeries
— ADO 2.5 - this ships with Microsoft Database
Windows 2000 — Supports ROW-ID
— Visual Basic 6.0 OLE DB controls and — 64K SQL Statements
wizards — Additional descriptor
— An OLE DB interface is provided to information P

support ADO recordset Seek (ADO 2.x)

Custom properties added

— Force Translate (translate CCSID 65535
data)

— Default Collection
— Catalog Library List
— Convert Date Time To Char

Supports updatable cursors for the
SQL dialect

Is thread safe
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64-bit Windows

@server’
ODBC, OLE DB

Intel Itanium hardware

» The ODBC and OLE DB
components have been

ported to run natively on 64-
bit Windows

64-bit Windows
Server

— Most other components will
run in 32-bit mode on 64-bit
hardware (print drivers and
SSL support will not run
with 64-bit applications).

MR

iSeries Access for
Windows 64-bit
— support (ODBC,
= OLE DB)
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Incoming Remote Command (IRC)

@ server’

« RUNRMTCMD is used to run a PC command from the OS/400
command line in a 5250 session

» Since it is a CL command, RUNRMTCMD may also be run from a
CL program running on a server

iSeries Access for Windows

+ CWBRXD is the name of the program that provides and controls the Incoming Remote
Command (IRC) function

— RXD in the name stands for Remote eXecution Daemon
— The terms CWBRXD and IRC are used interchangeably
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IRC enhancements in V5R3...

A new option: /loadprof

— Allows commands to have access to the

user-specific registry and environment
variable settings while they are running

@server’

* The Incoming Remote Command
function runs the command on the
Windows PC and then routes any text
output that is generated by the command
back to the requesting system

« Commands are sent to the Windows PC

— Some commands require setting this option in the format of commands that are typed

in order to work properly

— This option can be saved on the Incoming
Remote Command tab of iSeries Access
for Windows Properties, where it is called
Load user profile when command run in

user contex

For further information regarding this new
option, refer to the CWBRXD and Incoming
Remote Command topic in the User's Guide
— Use this path:
— Start > Programs > IBM iSeries Access for
Windows > User's Guide

on a Windows command prompt
— The output that would normally
appear in that command prompt is
sent back to the requesting system
— If the command produces no output, a
no output message is sent instead.

* When a command is sent from a remote
system, a message is logged in the
iSeries Access for Windows history log

—The message information that is logged
identifies the system and user ID that
sent the remote command, the text of the
command that was sent, and whether or
not the command could run

— If no user ID is specified with the
command, no user ID is logged.
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Use CWBLOGON to sign onto iSeries

CWBLOGON command —

@ server’

Simulates persistent password caching (ie, remembered across restarts)

Use to connect to an iSeries without being
prompted for Userid or Password

- Password in clear text - use appropriate security

measures. ]
» Documented in User's Guide

Quite useful if PC is set up as an iSeries printer

server (ie, PC5250 Printer Emulation always
running on this PC)

Useful on NT/2000/XP/2003 where Windows
password cache not provided

I
Add CWBLOGON.exe program %
o

to Windows start-up folder

CWBLOGON
system /u userid /p password
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iSeries Access Toolkit

[ Corterts [ Touhit s e

* Installable option of

% 0 Intmpsteed Fin Syeteen
] Progen (ol

# 121 Flemels Command

= (2 Sarvist and ML
220 User Space.

e cenaenene:  ACCESS fOr Windows
e ' “* « Included in the icon
e e o oo e g o group for Access for
e i urepe tbenghe of DB OB, .

Each of ete iedaces har advantage: and deadiantages Windows

NET Framamweek Clazsns .
choartagn:
Eay topropan
Aot pasy rbery

aabeariige
Piecond el accass. progesn call. and dafa queuet 8iE ot 11D

ADDAILE DR

Eay io pngran
Frorvades 501

Contains sample
programs, and
documentation

Also contains links to
header files and
Windows Help files
installed on your PC
Has Internet links to

more sample
programs,
documentation, and
other helpful
information

satvariinges
D 43 grogparn o, Housch rasiet than C 4F1
Lot e e rstiom D27 UTIR urstiors:

g rhetace
i o 5w s it sorvones bors JOIRE chvo i arvdatin]
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Toolkit enhancements - V5R2

@ server’

Data Transfer ActiveX Automation support

» The database transfer automation objects provide a programming interface
for the Data Transfer functionality.

Visual Basic wizards

+ Data types (Bigint, Large Objects (LOBs))

» Set cursor type and lock type properties

» Generate recordset seek code for tables record level access

Tools for Java

» Two new Java tools, GUI Builder and Resource Script Converter, are
included in Express.
— The GUI Builder is a visual editor for creating Java dialogs, property sheets and
wizards.

— The Resource Script Converter converts Windows user interface elements into a
form usable by Java programs. These tools are an optionally installable
component of the Toolkit, and require the current JRE and Java Toolbox.
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©2004 1BM Corporation

Data Transfer

@server’

iSeries. mySeries.

What is Data Transfer?

Provides an SQL-like interface

* To allow full file SELECT or customized
queries including joins, sorting, and
record grouping

* Provides access to iSeries file members

Provides an easy-to-use GUI so users
can:

* Download selected DB2 UDB for iSeries
information to a

— PC file

— HTML file
— PC display
— PC printer

» Upload PC data to DB2 UDB for iSeries
— From PC file

©2004 1BM Corporation

@ server
2:Data Transfer From iSeries D m| ﬁ
File View Help
hEd

iSeries
System name: -
Fil name: ’7 Bowse
Deata Options.
FC
Qutput device: ’h‘ Details. ‘
[Fl‘SMiV
e
HyperText Markup Language (HTML)
Printer
Fomat Options

- - =
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Many Other Ways to Run Data Transfer...

@server’
Batch Transfers Can be started from:
+ RTOPCB and RFROMPCB
« Can also run multiple batch - PC5250 Toolbar

requests on a single connection - Express icon group

- Desktop objects or Explorer

* Create new ones from Windows
New menu

Pre-defined Transfer Request

Auto-run without user
intervention
Compatible with previous formats (ie,
Can be placed in a start-up file Enh.Win3.1, RUMBA)
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Automating Data Transfer

@ server’
You could schedule Batch Transfers using a Windows Scheduler

|
1 Scheduled Tasks !EI ﬁ
J File  Edit Yiew Go Favoites Advanced Help |
RTOPCB is N = | =
e % ek 4BA0XEE-
scheduled _
t t Mame | Schedule | Mext Run Time | Last Run Time |
hakbata (=] A Schecided Tk
gIVen date ~ gMaintenance-Deflagmenl plograms Disabled Disabled Newer
g ~ Maintenance-Disk cleanup Disabled Disabled Mewer
and time A~ @Maintenance-ScanDisk Disabled Disabled Never
rlopch At 328 PM every day, stating 210, 32800 PM 3/7/00 JZFE6PM 3/6700
W\ndows Critical Update Motification Every 5 minute(s] from 7:20 PM for .. 7:20:00 PM 3/6/00 Mewer

d
[B abjecti)
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Notes: Scheduling a Data Transfer Request

@server’
iSeries Access for Windows does not provide a scheduler program. For an example of how to
schedule a Data Transfer request, we picked Microsoft's System Agent application.

From Microsoft Task Scheduler select Add Scheduled Task. Go through the wizard to create
the scheduled task and enter

"C:\Program Files\IBM\Client Access\RTOPCB.EXE" your.TTO
for the task to execute.

Complete the other scheduling options offered by the System Agent application. You are now
ready to run transfer requests on a scheduled basis.
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Data Transfer Provides Data Conversions

@ server’

Capable of transferring
data to and from many
popular PC file types
including:

ActiveX Automation support
for all Data Transfer GUls

» ActiveX automation objects

for transferring database data
« ASCIl Text fco ar_'ld from iSeries and
iSeriese servers.

* CSV * These objects provide both a
* Excel and Lotus high-level and a low-level
spreadsheet types interface.
» Tab-Delimited Text » These objects can be used
- UTF-8 & -16 (used by from Visual Bé.lSIc and other
languages which support
browsers)

ActiveX automation.

©2004 1BM Corporation
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Create iSeries Database File Wizard

@server’

To help you create new [®: Data Transfer To iSeries REX]
tables in DB2 UDB for Elo View Tods o
iSeries, use the O NEAI
Database File Wizard
It also creates the File
Description File (FDF) L =l
reqUired for uploading 1| Create iSeries Database File E
the data to a new file "

This wizard allows you to create an iSeries database

file from an existing PC file

Start the Create iSeries
Database File tool by:

You wil be required to specify the name of the PC
file from which the iSenes fils will be based. the
niame of the iSeries file which to create, and several
other necessary details

+ Selecting it from
the Tools menu, or

* By clicking on its
icon in the toolbar

Cancel | Hep |
©2004 IBM Corporation iseries. mvseries.
Notes: Create Database File Wizard .
@ server

In iSeries Access for Windows, Data Transfer now has the ability to define and create a new iSeries database file based
on an existing PC data file. The new file is created as an SQL table. In previous releases, Data Transfer was only able
to create files based on existing iSeries database files. The new function will also create the FDF file required for
uploading the data to the new file. The interface to create a new database file is found in the Data Transfer to iSeries
application. The function can be started from the Tools menu or a new toolbar icon.

The first step in creating a new iSeries database file is to specify the PC file that you want the file based off of. The file
can be in any of the following formats: ASCII text, BASIC Sequential, BIFF3, BIFF4, BIFF5, CSV, DIF, Tab-delimited text,
or WK4. If you pick a file type containing detailed type information, such as BIFF or WK4, Data Transfer is able to more
accurately determine the definition of the iSeries file you will want to create to hold your data. After specifying your PC
file, Data Transfer attempts to determine the type of the file. The type detected by Data Transfer is shown in the window.
If this "guess" by Data Transfer is not correct, you will need to set the correct file type before you continue. If this is not
done, Data Transfer will not be able to read the data file correctly, and an error will be displayed.

The information you enter along the way in the wizard will be loaded into the Data Transfer to iSeries application upon
completion of the wizard function. The FDF file is an essential item for step of transferring the data to the iSeries. This
panel allows you to set the name of the FDF file to be used for the transfer. In order to retrieve the field information from
the PC data file, Data Transfer must "scan" or parse the data. If you chose not to do this, you will be required to manually
set up the field definitions from scratch. If you run the scan operation, Data Transfer will scan the PC file and come up
with a first pass at what the field definitions of the new database file will need to be to hold the data from the PC data file.
If you chose to have Data Transfer scan the PC data file, you will be presented with a list of fields found in the PC data
file. If you chose a simple file type such as ASCII text, the field definitions will almost always need to be modified. If you
chose a more complex file type such as BIFF or WK4, only minor modifications may be needed. Either way, it is a good
idea to verify the field definitions are going to allow for all possible values you will want to insert into the iSeries database.
A context menu (right click in Details list control) is available to allow users to add to or remove fields from the list.
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Data Transfer Vs FTPs

Use Data Transfer rather than
multi-step FTPs

» Rather than taking PC data
and performing FTP to IFS
then using CPYFRMPCD to get
data into database format

* Use Data Transfer

» Same is true when getting data
from the database to the PC
(ie, CPYTOPCD)

@server’

Database

©2004 1BM Corporation
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Data Transfer and Excel integration...

Data Transfer has add-ins for Excel users

@ server’

[¥ Microsoft Excel - Book1

° Can download from File Edit View Insert Format Tools Data Window Help
DB2 UDB for iSeries oa,

directly into ZRav Rr-4 e 2w
spreadsheet at @
— Can create request H~ EOON
q 7 I I T - I - I ] KL
—Can run previously | {[EIEILsmA W SREET CTY - STATE ZFCOD COTLT CHGCOD BALDUE COTDLE
2 0BT Heming GK  4859Fim Dallss  TX 75217 5000 3 37 0
saved request 1| 83283Jores  BD  21BNWICay  NY B 40 10 0
4 3W9Vie  SS  POBox7Broton VT 046 00 14 0
5| 93B485Jomson JA  3ApineWHelen  GA 0545 9999 2 375 35
. 6 372%7Tyon  WE 13 Mydle[Heclor NV a4 1000 1 ] ]
Can upload Pc data to 7| 389572 Stevens KL 208 Snow Denver  CO 80226 400 1 58.75 15
DB2 UDB for iSeries B BEM3MIson  JS  ToTlskellde M 56342 5000 3 10 ]
. 9| 4769%Doe  JW  9Acher Suter CA 9665 700 2/ 0
directly from 0 G329 Thomss AN 3Dow CiiCasper WY 6609 9999 2 0 0
11] 593029 Wilams ED 485 SE2/Dalles  TX 218 200 1 % 0
spreadsheet 12 19937Lee  FL 5930k Hector NY g 700 2 495 05
_ Added in V5R2 13| 583900 Abraham MT  392MilStlsle M M2 9999 30 0
1

15
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Enhancements for Excel users - V5R2

X Microsoft Excel - Bookl N =]
B Ele Edit Wiew Insert Format Teols Data Window Help == 5||

SHSRERY | mET oo

|8 & = ~ “l Allﬂgﬂ\wﬂ%

I@!

When using

“nclmsuEmEE e W
"*‘O-lt‘;ﬁaFavontesv‘GOv‘%hnakl
Al =] =[ CUSHUM

Microsoft Excel

Transfer to AS5/400 Request

Starting cell position:

Column: A& How: I 1

Ending cell pozition:

Column: K| How: I 13

i~ Transfer Request

" Create new
& Create from file [ dtt, * tr, *.dt, =1ta)

|— Browse |
o]

Help

Cancel |

M [« [» [l Sheet1 & Sheetz £

— Now support
Version 7 (BIFF7)
and Version 8
(BIFF8) file
formats. Excel
97 and 2000 use
the Version 8 file
format.

— Support for
numeric formulas
within cells.

mJJ_I

Ready

'W!_I_IW!_I_I_ Z
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Enhancements for Excel

users - V5R3

@server’
» Support most recently
used request list and
last dlreCtory in Excel I Microsaft Excel - QCUST_with datalfiel. =18
Add-in il Vew Isst Foma: Teok Jsa Uindow Hep -8l ﬂ‘

e

Date/Time fields

DEMG[ERY|sBR k244
¥ N =

recognized by Data 3 ‘ LB | E |G
Transfer and now ﬁEATE CUSHUM STNAM T STRZET OITY
2] 12 12366 DA Alyoneuinl Rach
Stored on DBZ for (3] 2400 112356 DA AlgoncuiniRoch
iSeries as 'date or LD 20 DA Ao
H v g |5 sm 31346 DA AlyoneuirzRach
time' field. (6] 4802 4135 DA Ayuinoch
|7 10302001 51586 DA AlgoncuiniRoch
. |8 48000 61356 DA Alyoneuint Roch
M Optlon to convert 9| 18 455 DA AlnouinRoch
0 10123072002 81286 DA AgoncunfRoch
numeric to Cha_raCter (1| 1Az002 91735 DA Alyoneuint Roch
when transferring to 0 1B DA AgonouniRoch
iSerieS DB | 13\ 4/3_/20?? HZBLEE D/-\ r\\guntumﬁuth

Support data
compression for faster
transfers

0
2
4
[

i
10
12
14
16
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il
2
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Notes: Convert Excel data and time cells .
@ server

Convert Excel date and time cells to iSeries date and time
allows the transfer of standard Excel internal date and
time formats to the iSeries without requiring conversion.
Typically, date and time cells uploaded to the iSeries must
be character strings. By enabling this option, Excel data
can be converted to an iSeries compatible date or time
without requiring prior conversion to a character string.

Convert numeric data in character columns to
character data - allows the conversion of
numeric cells in spreadsheet data to be
converted to character. With this option
disabled, numeric cells in character columns
cause Data Transfer to end with an error
message. By enabling this option, you can
specify that numeric cells are converted to
character on the upload to the iSeries to avoid

The following standard Microsoft Excel date and time Data Transfer ending when it encounters

formats are supported:

numeric data.

Format string Example .

NOTE: Converted character strings are not
m/dlyy 10/01/74 verified by Data Transfer since the expected
m/dlyyyy 10/01/1974 string cannot be determined. Data loss could
d-mmm-yy 01-Oct-74 occur during the conversion.

d-mmm 01-Oct

mmm-yy Oct-74 In the past, customers could not upload this
rnm AMand PHL 1015 A gol. o ey oy wshg e opton
h:mm:ss AMand PM  10:15:22 PM ZIP+4 data is character and 5 digit ZIP codes
h:mm 18:22 are numeric.)

h:mm:ss 18:22:34

m/d/yy h:mm 10/01/74 6:20

mm:ss 18:25

[h]:mm:ss 18:25:32

mm:ss.0 25:23.0
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Enhancements for Lotus users - V5R2

Lotus SmaritSuite
[ File Edit View

- 1-2-3 - [Untitled_123]

Create  Bange Shest ‘wWindow

@server’

Bel |

Q]

Frint \\

F'review// C |

Help —Support 97 Edition
spreadsheet formula
the numeric value.

numeric value it will
# New in V5R2 version
* With 65,536 rows

New in V5R1 version
(123)
|£| + —When transferring a
.
cell, Data Transfer
| now tries to determine
* If the formula does
not resolve to a
continue to pass a
value of 0
14
—Support Lotus 123
Version 9 file format
(Version 97 support
8,192 rows)
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Notes: Enhancements for Excel @server'

and Lotus 1-2-3 users

Lotus 123 .123 file support added, The .123 file type is the standard type used in 97 Edition of Lotus 123. Lotus .WK4 support
was added in release V4R4. The current .WK4 selectively installed option is expanded to include .123 support since these file
types use the same LMBCS character conversion routines. The .123 support includes UNICODE character set support and
support for new .123 numeric storage types. These types are defined in the Lotus .123 file format specification. Like .WK4 file
support, .123 file format support includes the capability to read and write records to multiple sheets within a single workbook.
Support for these types is also now included in the 'Create iSeries Database File' wizard.

Upload from Excel Add-In. Today, Data Transfer provides the ability to download information into an Excel spreadsheet. This
function is integrated into the Excel by providing (1) an Excel add-in module called cwbtfxla.xll, (2) a toolbar icon/button the user
can select to invoke a Client Access data transfer GUI, and (3) a menu option from the Excel "Data" pulldown menu called
"Transfer Data From iSeries..." Data Transfer now extends its integration with Excel by providing an option to upload
information from Excel to the iSeries. This additional integration include (1) an additional icon/button on the Client Access
toolbar, (2) an additional menu option on the Excel "Data" pulldown menu called "Transfer Data To iSeries...", (3) a new dialog
similar to the current download dialog, which allows the user to specify what data to upload and where to upload it to. A new
DLL to be shipped and installed to provide this new capability.

Microsoft Excel BIFF7 and BIFF8 file support - support for the Microsoft Excel Versions 7 and 8 file formats. Version 7 support
is simply an extension of the Version 5 file format which Data Transfer currently supports. The major change from Version 7 to
Version 8 is that in Version 8 character data is stored as UNICODE. Like .WK4 file support, Excel Version 8 support includes
the option to save to multiple sheets within a workbook. Support for these types also has been added to the Create iSeries
Database File wizard.

Previously Data Transfer "ignored" formula cells and passed the default value of the field type to the iSeries. For example, a
numeric formula cell found in Excel today would cause Data Transfer to pass a value of 0 to the iSeries database file. Data
Transfer nows determines if the formula is for a numeric value. If it is, Data Transfer pulls the result of the formula from the cell
and passes it to the iSeries database file. If the formula does not resolve to a numeric value, Data Transfer will continue to pass
the default value for the cell type.
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Data Transfer enhances e-business

@ server’

CHAR CHAR DATALINK
name address website
Rochester | http://www.as400.ibm.com

xSeries running a
Integrated L
sgwer Data .‘:
Transfer e
web server request _
HTML Tables Can download iSeries database information directly into
HTML tables
Update an existing Database information can be inserted directly into a section
HTML file with new of an existing HTML file. A ‘template’ section is used to tell
DB2/400 info D/T where to put the resulting table in the HTML file. This

enables users who have web pages of text/images update a
section of database information yet leave the rest of the web
page text intact. Previously the entire HTML file was
replaced with a table containing the database data.

DATALINK data type 0S/400 V4R4 added a DATALINK data type. This type
support supports url entries pointing at files accessible by your
network. When transferring to an HTML table Data Transfer
provides a link for this url
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Data Transfer - V5R3

@server’

Unicode enablement / New Unicode text file type
— Support for UTF-8 and UTF-16 data in DB2 database tables

DXFERUNI/MIXUTYPE

UTF8 ucs2 UTF16

ABC ABC ABC

00 e®Q edQ

Ons Onsa OnsA

N1 N1 N1

b s b

4 »
Retrieved record 7

Many different characters from many languages from a single character set
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Notes: Unicode data support

@ server’

Unicode allows the use of many different characters from many languages from a single character set. In
today's global economy this is extremely important. For example, a product description could be stored in the
database in 10 different languages and used during product packaging for all these languages.

Here are some of the Unicode features added to Data Transfer in V5R3:

«True Unicode support in Microsoft Excel Version 8 files.

*A new Unicode text file format that allows you to store data in UTF-8, UTF-16, or Big-endian UTF-16.
*Unicode display support.

*Unicode print support including configurable fonts.

«Support fo UTF-8 and UTF-16 native DB2 column types
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Other enhancements...
@server’

V5R3 Data Transfer enhancements:

— Support for larger decimal precision

— Support for BINARY and VARBINARY SQL data types
V5R2 Data Transfer enhancements:

— Support for uploading more than 256 columns of data to a
database file

— Support new iSeries database functions

©2004 IBM Corporation iseries mvseries
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@ server’

PC5250 Display & Print Emulation

©2004 IBM Corporation iseries mvseries
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PC5250 V5.7 included in V5R3MO... .
@server

New in PC5250 V5.7:

— Accessibility enhancements to the
operator information area (OIA):
Popup keypad, and Color
mapping as well as visual
indication of sounds

— Enhanced mouse marking

Bidirectional (LamAlef)

Personal Communications
iSeries Access for Windows

WorkStation Program
Version 5.7 for Windows

Licented Material - Property of [EM

enhancements Copyright IBM Carp. 1983, 2003, Allights reserved
U5 Govemment Users Restricted Rights -
- USB Japanese 106 keyboard Use, duplication or disclosue resticted
by G54 ADP Schedule Contiact with [BM Corp.
support

20031002

— Basic_ascii print PDF and PDT

[1 PC5250 V5.5 included in iSeries Access for Windows V5R2 version

©2004 IBM Corporation iseries mvseries
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Notes: PC5250 Emulation

@ server’

PC5250 display emulation enables users to run iSeries
programs, work with OS/400 screens, and to send iSeries
output to PC printers. PC5250 display emulation supports up
to 26 sessions to one or more iSeries systems. To configure
and start an emulator session:

The new “Basic_ascii print PDF” enhancement is
that all print formatting commands are omitted
except for the following:

BEGIN_MACROS

1 Start the PC5250 configuration program. BAKEQU 08 /: Back Space :/

2 Select Display for the session type. TAB EQU 09 /. Tgb ./

3 Select the size for the session. LFF EQU 0A /‘ Line Feed ./

Note: Do not use End Connection *YES to log off your FFF EQU 0C I‘Form, Feed ,/

emulator session and disconnect from the iSeries. Instead, CRREQU 0D I" Carriage Return !
END_MACROS

select COMMUNICATION from menu bar then select

DISCONNECT. This is useful in cases when you do not want to

have the host output to be formatted according
to the host application, ie, you want to see the
pure text (and things like horizontal position,
vertical position, CPI, LPI, font name, bold,
underscore, italic, etc, do not matter) and you
possibly want to direct the output to a flat ASCII
file for further viewing.

If you run a host print test to a file using a "normal”

PC5250 print emulation can be used to print iSeries output
on printers known to the iSeries -- this could be a network
printer or a PC-attached printer. Up to 26 printer sessions
can be simultaneously running to one or more iSeries
systems.

To configure and start a printer emulation session

1 Start the configuration program.

2 Select Printer for the session type.

3 Click the Setup button to configure additional options for
the printer session.

Help text is available if you need additional help with the
options.

PDT file and to a Basic ASCII.

The file created with the "normal" PDT will have some
binary "garbage" - escape sequences of the print
formatting commands.

The file created with Basic ASCII contains only those
formatting commands which are common between
printers and text processors, like FF, LF, CR.
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New Service Pack coming in March

@server’

New V5R3 Service Pack to be available in March 2005

One important function being provided is PC5250 High Resolution
Fonts

— PC5250 will now display properly at higher resolution screens.

Additionally, for the first time, a new version of the Java Runtime
Environment (JRE) will also be included in a Service Pack

— iSeries Navigator requires the new version in order to address customer
problems.

— Formerly we only updated JRE versions on a release boundary.
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PC5250 V5.5 (V5R2 enhancements)

Usability...

- Bypass sign-on can now be used
in conjunction with Kerberos
tickets to avoid a sign-on screen

Wrap pasted text. Allows the
paste of copied text across fields
and lines without breaking in the
middle of a word, or ending a line
with an invalid word.

Move +/- sign before the number
when copying/pasting - for
consistency with other Windows
applications

* Improved error messages

@server’
National language support
» Support has been added for Hindi

and Japanese code page
1390/1399
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PC5250 Enhancements — V5R1

@server’
B Configure PC5250 B x|
GUI dialog now provided for Srenrene e [
configuring workstation id Y
 Use Computer hame I7 Add prefiv o indicate printer o display
— Use Computer name % Use Windows user name I o dupkicale names on tis noikstaton
. -  Specily workstation 1D I7 Awid duplic ate names with other workstations
— Use Windows user name I
— Specify a workstation ID Turecae
© Beginning characters @ Ending characters
. Type of smulation
Bypass signon & Dighy e (@]
— Reduces need to sign on Ll
again at OS/400 screen -
¥ Bypass signon
17 Autgreconnect
. e —
Foit number 'ﬁ—
oK Cancel Help
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Centrally Manage 5250 Use

Let’s say you would like to
control:

* What the users can do with
PC5250

— Number of sessions they
can start, systems they can
connect to, change
keyboard mappings, etc

* Manage all of this on your
server so you could change
something in a single
location and make it available
to all users
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PC5250 Enhancement — V5R1

Can have multiple 5250 sessions
with just one .WS profile

— This gives you ability to:
Set up and manage the

iSeries servers your users
connect to

Make all 5250 workstation
sessions look identical

— Screen settings
— Keyboard

.WS profile
stored in
here

* When you make a change to
these profiles, it will
automatically be made for
all users

©2004 IBM Corporation iseries myseries
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Steps to use the shared .WS profile concep(b server'

1. Set up a shared directory and give all users ‘read only’
access to it

2. Use Session Manager to configure the
connections/sessions for your users and save these
Profiles in your shared directory

3. Install iSeries Access for Windows and PC5250 on each
user’s PC

4. Gointo iSeries Access for Windows Properties and set
each users PC5250 default path to point to the shared
directory you created.
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Store Profiles on Server

@server’
Go into iSeries Access for Windows, r——0 0 =
select ‘Emulator’, then select to P =
Start or Configure Session o =]

— This is called the Session
Manager. It enables you to:
» Start a new session
» Configure a new batch session
+ Start an existing session

me b b

— Select ‘New Session’ it
* Now configure the
sessions/connections that you
wish to provide to your users.
+ Save them in your shared
directory
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At the User’s PC

@server’
Set PC5250 to look for 5250 emulator files on shared directory
Bring up iSeries Access for iSeres Accessfor Windaws Properties B[]
Windows Properties and select = L o L [
the PC5250 tab coming Remote Command | Diagnosic Tools | Senvice PC5250 ‘ Other
Path to PC5250 emulator files
o Copy any files stored in the  (Seres Ancess inaletion drectory
\Private folder to your shared o remnie
directory (& User speciied path
IW\MY\SEHJES\PEZEA]FROHLES Browse..
° _Cha_nge the def_ault from the PC5250 workstation profile to use from iSeries Navigator
iSeries Access installation  Defaut e
directory to User specified path £ Gstorized pfle
* Then put in server address thatall| .
your users have read-only access :
tO J.ﬂutamahc ‘migration LJ
This needs to be done for every iSeries Access o
for Windows user. If more than one user on a LJ %

single PC, use CWBCFG command from a
DOS prompt to change path for all users.
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At the User’s PC

@ server’
Fortatul Componications - Session Mirager -0
Go back into the Session Manager o
¥ 9 =]

— Start > Programs - iSeries
Access for Windows, select

‘Emulator’, then select to Start

or Configure Session

— Put the sessions you want the
user to have access to on the
user’s desktop

el S

2 b
| (=]
== = =

cmiver Printer Session
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* Use Menu Bar

Customization Utlllty ; i Menu-Bar Customization Utlity ifM Programmer's Toolkit

[ Multiple Sessions

| (& startor Configure Session
I 77@ Trace Facility

“new” connections, Menu: tems:
remove Properties... e AJ| Delete
Edit b Print Screen
+ When you are o ‘- } | £
. . Commurication b Print Graphics

finished, store this S » Pirter St =

also in your shared Viirdow e

directory Help »

to eliminate the items
you don’t want users

Convert Macro

I service »
AFP Workbench Viewer
28

Data Transfer From iSeries Server

to be able to perform.

— For example, disable | 2 Menu-Bar-Customization Utility - BYPASS SIGNON FOR LP USE....[~ | 1

users’ ability to create Fie Help
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Notes: Menu-Bar Customization Utility

@server’

This utility enables you to remove items from the menu bar of the Personal Communications session window; the changes
affect only the session that you customize, so you can make different changes to each session. You can remove the

following three types of menu items:

« - A menu bar command, such as File, Edit, View, and Help.

* - A pulldown menu command, such as New, Open..., Color Mapping, and Configure.
< - A separator line that resides between two commands in a pulldown menu.

The instructions to modify the menu bar are saved in the workstation profile that you choose and become active next time you

start the session.

How to delete menu items

Note: If you want to delete all menu bar commands, do not use this utility. If you use a workstation profile which has no menu
bar commands, no less than one menu bar command will appear. Instead, deselect View -> Menu from the session window.

To delete menu items, do the following:

1. Select the Menu-Bar Customization Utility from the IBM Personal Communications -> Utilities folder.

2. Click File -> Open.

The Open WorkStation Profile window appears.

3. Choose the profile and click OK.

The menu items appear in the Menu and ltems list boxes

4. Choose a menu item to be deleted.
5. Click Delete.

The menu item which you chose is removed from the list box.

If you accidentally delete the wrong item from the either the

Menu or Items list, click Default---this restores all the default menu selections for the profile.

6. Repeat the previous two steps until you have deleted all the menu items you want.

7. Click Exit.
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Control Access to PC5250

@ server’

Policy Administration

» Based on Microsoft System Policy
support

» PC user has one set of policies for
connectivity to all iSeries servers

» Can set policies on a specific PC as
well as users and groups

» Can be used to 'configure' as well as
restrict functions

» Uses Microsoft System Policy Editor
and Client Access Policy templates

The Microsoft Way...

» Preferred method for those familiar or
already using Microsoft System Policies

Applications Administration

» Based on OS/400 user profiles -- thus
supports users and groups

= User profile can roam with user (from
any PC)

« A user can have different profiles for
different iSeries

 Can restrict usage of Operations
Navigator functions, Client Access
functions, APIs available for use by
other plug-ins

» Easy-to-use Operations Navigator GUI

The iSeries Way...

 Preferred method for those who want
to control access via OS/400 user
profiles
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PC5250 Restriction Options .
@server

1 il

Prevent usage of PC55250 emulator

Prevent configuration of display sessions

Prevent configuration of printer sessions

Maximum number of PC5250 sessions

Prevent changing of .WS profiles

Prevent menu configuration

Prevent toolbar configuration

Prevent multi-session configuration

Prevent keyboard configuration

Prevent mouse configuration

Prevent JavaTM applet execution

Prevent access to macros

Prevent profile imports in Emulator Session Manager

Prevent profile deletion in Emulator Session Manager
Prevent directory changes in Emulator Session Manager
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Get the Microsoft System Policy Editor

@ server’

| & Mesmalt oftce P Resonsce it Tocis | (] Arswer Wizard Bulder 1

Go to Microsoft web page
and download and install
“Office XP Resource Kit”

— http://www.microsoft.com/
windows/default.mspx

— Search on ‘download system
policy editor’

The Microsoft System Policy
Editor is in the Office XP
Resource Kit

— To find it click:
» Start > Programs >
* Microsoft Office Tools >

* Microsoft Office XP
Resource Kit Tools 2>
System Policy Editor

Note: Get the Policy Editor which
matches your Windows Operating
System

o || (] et oo orpareer
W Mol Dfce Acpleation Biecevery
B Mol e Docurent Irogeg
3 Mool Olbee Docrment Searrwsy
[ Mt Cfe Sharteut Bar
) Mo e 1P Langusge Seregs
iy Mot ot Edor

| £5) seve My Settngs wiord

T oo P Ve

M Corporate Emor Reparting
B Custom Instalabion Wizerd
W custon Mantenance Wizad
) MST Fie ewer

B7) ops Fle Vewer

£ Pockmge Defrvton Fies
) profie Wasrd

Bl Removal Wizard

W Setun INL Customzation Wizand

About System Policy Editor

=

‘Copyright © 1985-2001 # vy
Microsoft Comoration

& Syshem Polcy Edior

XDJ
Microsoft ® System Policy Editor

Version 5.1 (Build 2600 x95p2,040913-1003 ; Service Pack 1)
Copyright ® 1581-2001 Microsoft Comporstion

* 'y

ed under the terms of the End-User
0!

Physical memory available to Windows: 1.047.472 KB
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Create iSeries Access for Windows Templates

@server’

Create iSeries Access
for Windows Policy
Templates that can
be used with the
Microsoft System
Policy Editor

— Run iSeries Access
for Windows
CWBADGEN utility to
create the templates

— CWBADGEN is in
Program
Files/IBM/Client
Access path

— On a DOS prompt,
run CWBADGEN /std
to create the
templates needed for
PC5250 policies

[ Command Prompt o

{C) Copyright IBM Gorporation and Others 1984, 2883. A1l rights reserved.
.8. Governnment Users Restricted Rights - Use, duplication or disclosure

restricted hy GSA ADP Schedule Contract uiti IBM Corp.
Licensed Materials — Property of IBH

: cwhadgen [/ps <{fileMName>] [/cfg {fileName>] [/stdl
cwbadgen /ps 51834345

Generates per-system template for system S1634345.
Output filename iz §1@34345.adn

cvbadgen /std
Generates caecfg.adm, caeinsrt.adm, and caerestr.adm
cwbadgen /cfg config.adm
Generates info to configure systems and environments from
existing configuration information. Output filename is
config.adn

:\Progran Files\IBMN\Client Access>cwbadgen /std
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Create PC5250 Policies

@server’
Start Microsoft System Policy ) Default User Properties
Editor and from toolbar select: Policies |
1. Options - Policy Editor > Add + @ OLE DB Provider ~
-~ Go to the Program : E
Files/IBM/Client Access directory guration of dispiay sessions
and select the caerestr.adm file e SZQ”ET.LEK;T.ZT:?“*
that was created by CWBADGEN revent changing of WS prfics
utility and add it to the Microsoft Prevent menu configuration
H R H Prevent toolbar configuration
SyStem POIICy Editor list Prevent muhiﬁessiangcuﬂﬁgumﬁuﬂ
Prevent keyboard configuration
. . Prevent rfigurati
2. File > Open Registry - Local < S > ¥
User
+ Double click on the IBM iSeries
Access Runtime Restrictions
template
» Select PC5250 emulation and set
the restrictions you wish to
impose, then click OK. Cancel
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Store Policies on a Shared Directory

@server’
Still in the System Policy Editor ~ Z7het i i oo i s st . 5
DEd pReX
5 0
- Select File > Save As é_ i

- Save the Policy Files you just
created on a shared directory that

each PC user has read only access
to

— The file getting saved has a
.POL file extension.
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Get address of .POL file on every PC deskto
é server

When Windows is started, it needs

How to get CWBPOLUZ.exe to run
to load the policy information to on every PC
_put into effect before completing — Manually run this command on
Its boot-up. each PC when you are setting it
up
Provide Windows with the location « This could be directly at the PC
where the policy file is stored. - Or you could Log onto the PC
remotely
* Use the iSeries Access for Windows _ Use iSeries Access for
stored.

run on remote PCs
— Download this command from — REXEC, etc
http://www.ibm.com/eserver/
iseries/ access/cadownld.htm
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@server’

Security Considerations

©2004 IBM Corporation iseries myseries
- L

Long Password Support
@ server’

« Connections to iSeries servers can now be done with
128-character passwords, for better security.

* The Password Level (QPWDLVL) must be set to 2 or 3 for these long

passwords to be used. ST =
— A value of 0 is the default and allows 1 to B oo B
10-character passwords. L —
— A value of 1 allows 1 to 10-character Pt [
passwords and iSeries Netserver
passwords for Windows 95,98,Me will be _Canel |

removed from the system.
— A value of 2 enables 1 to 128-bit passwords.

— A value of 3 enables 1 to 128-bit passwords, and iSeries Netserver
passwords for Windows 95,98,Me will be removed from the system.

- Password level can be modified in green screen, or through Security
->Policies within iSeries Navigator.
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40-bit and 56-bit Encryption Removed

@server’

On iSeries
 Cryptographic Access Provider
LPP (5722-ACx)

—AC3 = 128-bit
+ Client Encryption LPP
(5722-CE3)

—CE3 = 128-bit
On PC
+Client Encryption LPP
(5722-CE3)

—CE3 = 128-bit

New:

128-bit SSL included on V5R3
iSeries Access PC CD

Component Selection

Select the components you want to add. Deselect the components you
remave. Components already checked are curmently installed.

Companents Size| License b
] Express Required Programs |
B m Express Optional Camponents
W] () £3/400 Operations Navigator
-] dm» Data Access
[ g AFP Workbench Viewer
v ﬁ A5/400 ) ava Toalbox
Hw! [ﬂ Secure Sockets Layer [S51]
&E Client E nciyption: 56-bit
@I Clignt Encryption: 128-bit

] P —

4

5

Diive: C: Space Required: 0K Space Awailable: 1303296 K

Help ¢ Back ||
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Notes: SSL

@ server’

Secure Sockets Layer (SSL) is a popular security scheme that allows the PC client to authenticate the server
and encrypts all data and requests. Use it when transferring sensitive data between clients and servers. The
transfer of credit card and bank statement information are examples of client/server transactions that typically
take advantage of SSL. There is an increased cost in performance with SSL because of the added encryption
and decryption processing.

iSeries Access for Windows includes optionally-installable support for Secure Sockets Layer (SSL) and a way
to manage key databases with IBM Key Management. All functions of iSeries Access for Windows can
communicate over SSL except Incoming Remote Command and Ultimedia. However, on a PC using an Intel
64-bit processor, such as Itanium, only 32-bit applications and connections can use SSL. iSeries Access for
Windows allows SSL communications with the iSeries server at the 128-bit level of encryption.

Beginning in with iSeries Client Access Express for Windows (V5R1 version), client authentication is also
available for PC5250.
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@server’

iSeries Signon Information 21x]
Si formation has not b fied for this iSeri
B et The s i e ced sah e Support for Kerberos
you connect to this server. authentication Of users
Server: |MYISEHIESSYSTEM Kerberos ticket can
~iSeries signon information replace the sending of
Uz Windows uzer name and password, no prompting

userid and password

CMINER
- from a PC to the
Uselwemd iSeries.
» Kerberos

" Pra

authentication as a
new connection

[ ok | Cancel property to select

ze Kerberoz principal name, no prompting
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Notes: Kerberos Vs EIM

@ server’

We all want something to keep all of our passwords in sync for all of our iSeries. As computing environments get more
complex, and more and more servers are added, IT shops need a way to simplify the management of users across
disparate systems and applications. While managing user identities can be challenging in a shop with multiple iSeries
machines, the complexity compounds when you try to manage users across a network of dissimilar hosts. Additionally,
users often have different names on different systems and even different names within multiple applications on the
same system. System administrators aren't the only set of people who have multiple IDs, as application developers
build applications that pull data from multiple, often disparate, systems. These developers often must resolve the
differences in user IDs on all of these systems in order to make their applications function. And when they must, they
often compound the problem by implementing a new user registry to control access to their application. Finally, industry
studies say that a typical user has an average of 14 passwords to memorize between work, home, and various Web
interfaces. Remembering all those passwords is tough. Requiring hundreds of users to manage 10+ passwords apiece
makes our systems and networks inherently less secure.

Kerberos offers many advantages over other ways of managing the sign-on process. Some of the more important
advantages are the fact that passwords are not stored or transmitted in any clear text or de-cryptable form, user
enablement (or disablement) is done at a single point, and there is no way for passwords to get out of sync because a
user's passwords are not stored on every single system. Best of all, Kerberos is an industry standard that is already
supported in Windows(W2K and above), most versions of UNIX, and Linux. And as IBM rolls out their OS updates
through the rest of this year, look for support for EIM-enabled Single Signon on all of the servers in the eServer line.

On 4/29/2002, IBM announced Enterprise Identity Mapping,(EIM). EIM fits nicely into two prominent IBM initiatives:
eServer and eLiza. IBM also announced a Single Signon application that will run on top of EIM, but please don't
confuse the two. EIM is designed to allow system administrators to associate user registries (an EIM term) across a
variety of systems. Single Signon is the first application built on top of the EIM infrastructure, and it improves other
"password synchronization" schemes that have been available to iSeries customers to date. The Single Signon solution
uses the Kerberos network authentication protocol standard to authenticate a user and then grants that user a one-time
use, time-limited Kerberos "ticket" that the user can present to all of the Kerberos-enabled servers in the network. If the
ticket is valid for the system in question, access is granted. If the ticket is not valid for the system (or has expired),
access is denied. EIM and Single Signon are included with 0S/400
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Other Functions in iSeries Access for Windows

iSeries Navigator
Operations Console
EZ-Setup
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Notes: Sources of Technical Information

@ server’

iSeries Access web site is http:// www.ibm.com/eserver/iseries/access
+ Contains the latest information about the entire family of Client Access products, including Client Access Express
for Windows, such as late breaking news, Information APARS, FAQs, information on beta programs, how-to
information, service and support, new product announcements, plus much more.
+ Provides links to other important web pages, such as iSeriess Navigator, Operations Console, iSeries NetServer,
etc

Client Access Express for Windows Redbook (SG24-5191)
+ Access online by going to Client Access web page and selecting iSeries Client Access Express for Windows:
Implementing V4AR4MO, SG24-5191 from main page.

iSeries Information Center
+ Contains information on workshops, tools, and other technical information on topics such as Client Access,
Operations Navigator, Domino for iSeries and more. Also provided is an iSeries Client Access Express
Administrators Guide which has technical information on the Express client content for advanced users, such as
administration and programming documentation. This can be accessed by going to the Client Access web page,
then selecting 'iSeries Information Center' from main page.

iSeries Online/Softcopy Library
+ Is an entire library of iSeries books organized into bookshelves, accessible on CD or on the internet. The books on
the CD-ROM can be read using the IBM Library Reader program, provided on the CD-ROM.

Toolkit for iSeries Access for Windows

Toolkit ships with Express. Install it when you install Express, or later use Selective Install to get it. It also has
links to additional important programming information that is contained on the Client Access web page.
Information on OLE DB and Visual Basic Wizards is ats http://www.ibm.com/eserver/iseries/access/oledb
iSeries PartnerWorld for Developers web page (http://www.ibm.com/eserver/iseries/developer/ then search on
ODBC) contains detailed tips and techniques for developing ODBC applications.
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Web Information &9

@server’

DAy DA

iSeries Access web page has latest up-to-date information
http://www.ibm.com/eserver/iseries/access

For Information on

Information APARs on specific topics, such as Windows 2003 support
Access to all Red Books and other Reference Manuals

FAQs, Articles, links to Administrator Guide...

Select 'Additional Links'
iSeries NetServer for information on setting up your file and print
serving
— Operations Console for information on setting up a PC as your
system console
iSeries Navigator for i5/0S administration
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Trademarks and Disclaimers

@ server’

© IBM Corporation 1994-2004. Al rights reserved.
References in this document to IBM products or services do not imply that IBM intends to make them available in every country.

The following terms are trademarks of International Business Machines Corporation in the United States, other countries, or both:
Instruction: Refer to the following URL: ibm.com. html. Edit the list below, IBM subsidiary and special
which follow so they coincide with your presentation.

iSeries e-business on demand i5/08
iSeriese 1BM 0S/400
e@server IBM (logo)

Intel, Intel Inside (logos), MMX and Pentium are tré@efisks of Intel Corporation in the United States, other countries, or both.
Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and me Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
Java and all Java-based of Sun Inc. in the United States, other countries, or both.

Other company, product or service names may be trademarks or service marks of others.

Information is provided "AS IS" without warranty of any kind.

Al customer examples described are presented as illustrations of how those customers have used IBM products and the results they may have achieved. Actual environmental costs and
performance characteristics may vary by customer.

Information concerning non-IBM products was obtained from a supplier of these products, published announcement material, or other publicly available sources and does not constitute an
endorsement of such products by IBM. Sources for non-IBM list prices and performance numbers are taken from publicly available information, including vendor announcements and vendor
worldwide homepages. IBM has not tested these products and cannot confirm the accuracy of performance, capability, o any other claims related to non-IBM products. Questions on the
capability of non-IBM products should be addressed to the supplier of those products.

All statements regarding IBM future direction and intent are subject to change or withdrawal without notice, and represent goals and objectives only. Contact your local IBM office or IBM
authorized reseller for the full text of the specific Statement of Direction.

Some i icipated future ties. Such i ion is not intended as a definitive statement of a commitment to specific levels of performance, function or delivery
schedules with respect to any future products. Such commitments are only made in IBM product announcements. The information is presented here to communicate IBM's current investment
and development activities as a good faith effort to help with our customers' future planning.

is based on and ions using standard IBM benchmarks in a controlled The actual or that any user will experience will
vary depending upon considerations such as the amount of multiprogramming in the user's job stream, the I/O configuration, the storage configuration, and the workload processed. Therefore,
no assurance can be given that an individual user will achieve or equivalent to the ratios stated here.

shown are of engineeri . Changes may be incorporated in production models.
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